
GENERAL CLUB MEETING   

7:00 P.M. 

Midland Community Center 
2001 George St., Midland,  MI 

 
This month’s date:   

Wednesday - December 17, 2014 

 

This month’s topic:  

Holiday Picnic - Club will provide pizza,  
pop and table service. Please bring 
dish to pass 
 

January meeting - What’s in your 
toolkit? 
 
 

Program Coordinators 

Howard Lewis  lewis3ha@chartermi.net  

Bill Tower tower.w@gmail.com 
 

Please let Howard or Bill know of topics you 
would like covered at future meetings.  

 

President Piper’s Ponderings 
December will be our traditional pizza 
party. As in the past, it will be the third 
Wednesday, Dec 17, 2014, at 7 pm. 
Bring a dish to pass that will feed 6-8 
and the Club will provide pop, pizza 
and table service. Consider bringing 
your spouse. 
 
We will not have a specific speaker in December, but the 
Board decided we should have members bring a ‘silly’ or 
‘fluff’ website to show to the group. I think I have the 
sound problem solved, so YouTube videos would be in 
order. We will have plenty of time for questions.  
 
I am fascinated by year-end lists of top stories of the year 
and famous obits. I will try to collect a few of these lists for 
our December meeting. 
 
We also will be electing Officers for the coming year at 
our December meeting. It looks like we will not have a VP 
for 2015. 
 
Meeting topics for 2015 so far are: What Is In Your Tool 
Bag for January. Please be thinking of ideas which you 
would like to hear discussed in 2015. 
 
My Corporate background has me indoctrinated into 
writing goals for the coming year and listing my 
accomplishments for the past year. Some people do this 
in the form of a Christmas letter to friends. Some people 
call these resolutions. Consider making your own list if 
only to keep track if you are gaining or losing ground. 
 
Finally, I would like to thank all of the officers and 
members of our Club for their work and support in 2014. 
We all should be congratulated for keeping our Club alive. 
 
Have a happy, safe and healthy holiday. 
 
(The above comments are the opinion of the author and 

do not necessarily reflect the views of the Midland 

Computer Club.) 
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2014 MCC  OFFICERS 
President      Larry Piper  larryp56@chartermi.net 
Vice Pres.    Joe Lykowski joseph@lykowski.com 

Treasurer     Jan Ensing btiger6@juno.com 

Membership  Gary Ensing btiger6@gmail.com 
Editor 

Webmaster  

 
            Special Interest Groups: 
 

PROGRAM COORDINATORS 
Howard Lewis lewis3ha@chartermi.net  

Bill Tower tower.w@gmail.com 

  
 
PUBLICITY 
Al Adams aladams12@yahoo.com  

 

 

    Membership  Enrollment  Form        
 
       NAME  _______________________________________           PHONE  __________________ 
 
       ADDRESS  ___________________________________________________   
 
       CITY    __________________              ZIP  _______________       
 
        EMAIL ADDRESS     ___________________________________________ 
 
       Membership dues   FAMILY ($20)      STUDENT ($15)     New Member ____    Renewal   ____ 
 
                     Please fill out the above form and mail it along with payment of check or money order to : 
 
           MIDLAND COMPUTER CLUB         Attn: Memb ership Chairman 
              1816 Bauss Ct 
             Midland, MI  48642-4023   
                                                                      You may also pay for membership at a regular club meeting 

Board Meeting 
Next meeting will be Thursday, January 8th 

7:00 PM 

Chapel Lane Presbyterian Church,  
5501 Jefferson Ave., Midland MI 

 

Useful, useless and strange (in no particular 

order) Web Sites: (submitted by Howard Lewis) 

http://tinyurl.com/mopnpb8 
Although this site is billed as a resource on technology for 
teachers and educators, much of the information can be 
useful for the general population that is interested in the 
area of technology. So go browsing and learn something 
new today. 
  
http://tinyurl.com/levs6cs 
Over the years, Google has been known to modify their 
Search Page logo. These are called Doodles. This lists 
all of the Doodles that Google has used since 1998. 
Some of the more fun interactive ones were for the 30th 
anniversary of Pac-Man (5/21/2010) and the celebration 
of the Chinese New Year (2/10/2013), There are many 
other Doodles, some playable and others not. Another 
one, which isn’t a Doodle, is Googles salute to Atari 
game Breakout. Simply go the Google Search Page and 
type in “Atari Breakout” and select the link g.co/doodle. 
 
http://www.opencongress.org/ 
Check on how your lawmaker is doing and provide 
feedback, if desired, on the bills they will vote on. 
 
http://www.carcare.org/ 
Find all sorts of do-it-yourself type videos on car repair. 
You can also ask a technician for help on how to do  
various car repairs. 
 
http://www.chesscademy.com/ 
Chess is a great game for enhancing your thought  
processes. Learn how to play it for free. 
 

Carol Picard   webbyte@yahoo.com 



Bits and Bytes December 2014 Page 3 

 

Tips, Tricks, and Techniques (submitted by Larry Piper) 
 
Never, never, never give up.” Winston Churchill  
 
It started like the 3-4 floods our neighborhood has experienced in the past 27 years—it rained steady for a few days. 
By mid-week, we had almost an inch of water in our basement. Most of our belongings were in plastic crates—we had 
learned from previous floods. We immediately cut the power to our computers and any UPS devices we had. Our 
three computers in the basement all were on the floor, but they were on a 2x6 which meant they were a half inch 
above the water. We also had 2 backup hard drives that sat on the floor. Unfortunately, I forgot about one of these 
backup hard drives. When I remembered it, the drive had set in about an inch of water for 72+ hours. I think it had 
been powered off all this time. 
 
I did a thorough drying procedure on the HD. When I powered it up, I could see a blue light come on, but the 
computer never recognized it. It did not 'feel' like it was spinning. I repeated this test on a couple other computers 
with the same results. I did not know what was on this HD, but I did not fear it was something irreplacable. The drive 
was a Western Digital, Elements, 640 G, with USB and 110v power connections. 
 
I had given up ever recovering anything from this HD; I think I even put it in the trash can on a couple occasions. But 
I always rescued it, figuring I would find some miracle cure. I even put it in the freezer for 48 hours, but to no avail. 
 
By now 18 months has passed. I decided to remove the plastic case enclosing the HD. After 20 
minutes of prying, the case peeled off. I was left with a carrier that contained a circuit board. So 
I removed the carrier, pitched the circuit board, and I was left with a SATA drive. I connected a 
SATA power cord and plugged the USB connection into my desktop. I could feel no vibration, 
but after a full minute a message came up that a driver was being installed. Another minute 
went by and my PC recognized the flooded drive. 
 
I wasn't sure how long the flood drive would keep running, so I immediately did a copy and paste. There was 538 G 
of data, and it took nearly 12 hours to copy to another external backup HD. I recovered over 200 G of programs 
which I had downloaded over the past 5 years, 30 movies and 40 self-study courses. I have to conclude that the water 
had damaged the electronic circuit board, but not the actual drive. My message is: Never give up on a hard drive 
recovery. 
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Articles in this Newsletter have been obtained from APCUG with the authors’ permission for publication 

by APCUG member groups. The Midland Computer Club has not verified the information contained in 

the articles nor tested procedures or hardware/software. Articles do not necessarily reflect the views of 

the Midland Computer Club. 

 
 



Bits and Bytes December 2014 Page 4 

 

Accessing Charter Email When Traveling 
By Howard Lewis, Midland Computer Club, Midland MI 
 
When I travel, I usually take my Outlook database along with me to process my email. One problem that 
I’ve wrestled with for the last couple of years is that while I could receive email, I was unable to send 
email. I found a solution that worked for me and that was to simply use webmail. When on my last trip, I 
decided to investigate this problem in greater depth and found a solution which I am passing along in this 
tip. 
 
Using Webmail 
Using webmail is fairly simple, but does not provide some of the capabilities of a dedicated email reader. 
To access your email via webmail, simply go to the Charter website (www.charter.net) using your browser 
(Figure 1 ). 
 

 

Figure 1. Charter.com Main Page 

(One thing I noticed in preparing this tip was that Charter apparently is working on changing their website 
interface.) 
 
Once into the Charter website, select Sign In using your email address and the password to your email 
account (Figure 2 ). 
 

 

Figure 2  Charter Login 

At this time, for some reason, you will need to login a second time (Figure 3 ), again using your email 
address and password, but this time you will need to add your home zip code (this login process may 
change by the time you read this).  
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Figure 3 Charter Account Login 

You will now be taken to the Charter main page (Figure 4 ). 
 

 

Figure 4 Charter Main Page 

 
Next click on Email and you will be directed to your Charter Inbox (Figure 5 ). 
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Figure 5.  Charter Inbox 

Next, by clicking on New, the New Message screen will appear (Figure 6 ). 
 

 

Figure 6.  Create A New Message 

After you have typed your message, click on Send and the message will be sent to whomever you have 
specified on the To line. 
 
Using Your Mail Reader 
The solution to my Outlook problem was to change the SMTP server. 
 
When using a mail reader, two servers are utilized. One is the incoming mail server, which is usually 
POP3 or IMAP. The second server is the outgoing mail server. I have always used SMTP as my outgoing 
mail server in the past, but found out that by changing the SMTP server I could successfully send email 
while traveling. 
 
To change your SMTP server, use the following procedure (I am using Microsoft Outlook 2013, but other 
mail readers should be similar). 
 
First open Control Panel (Figure 7 ). 
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Figure 7.  Control Panel 

 
Next, select User Accounts and Family Safety (Figure 8 ). 
 

 

Figure 8.  User Accounts and Family Safety 

 
Now, chose the Mail applet (Figure 9 ). 
 

 

Figure 9.  Mail Setup 
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Next, select E-mail Accounts (Figure 10 ). This opens up the mail reader’s Account Settings  dialog box. 
 

 

Figure 10.  Account Settings Dialog Box 

 
Now, chose your email account and click on Change (Figure 11 ). 
 

 

Figure 11. Change Account Dialog Box 
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Now change the Outgoing mail server (SMTP)  from smtp.charter.net to mobile.charter.net and then click 
on More Settings (Figure 12 ). 
 

 

Figure 12.  Changed SMTP Settings 

The Internet E-mail Settings  dialog box is now displayed (Figure 13 ). 
 

 

Figure 13.  Internet E-mail Settings Dialog Box 
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Now switch to the Advanced tab. On this tab, the Outgoing server (SMTP)  port normally defaults to 25. 
This needs to be changed to port 587. For the Use the following type of encrypted connection  the 
default is None. This needs to be changed to SSL. 
 
Now you can click OK and close all of the dialog boxes. You should now be able to send emails from your 
mail reader wherever you travel. 
 
Since I have returned home, I’ve changed the SMTP server on my home system to the mobile settings 
and it appears to be working fine.  

 
 
Google Voice  
by Dick Orenstein, Member, Sarasota PCUG, FL 
June 2014 issue, PC Monitor, www.spcug.org, dicko (at) spcug.org 
 
Google Voice is a free telephone number that you can direct to forward calls to any other telephone 
number. In addition, you can block calls, receive transcribed messages, and do numerous other activities. 
Google Voice will also dial and connect calls for you; however, the call will be connected to another 
telephone number, i.e. your cell phone or your land line, as you direct. 
 
For a visual introduction you can go to this YouTube link: 
http://www.youtube.com/watch?v=cOZU7BOeQ58 
 
If this link does not work here are two things you can do: first, copy the link to the URL window of your 
browser, not the search window, the window with the web page address in it. And second, you can search 
Google (or any other search engine) for “Google Voice” and find a long list of assistance. 
 
You may be able to get a Google Voice number that is within your area code, but in today’s world the area 
code of the number is not necessarily an indication of the location – witness mobile phones. Most of us 
have a mobile number from our home base, but if we move, most don’t change the number. And in my 
case, I have a mobile number from there, but have a Google Voice number from this 941 area code, and 
calls get routed to my cell phone! 
 
To get a Google Voice number, sign into Google Voice (you do have a Google Account don’t you?) by 
going to the URL, www.google.com/voice.  If you don’t have a Google Account (some-name-you-
choose.gmail.com), you can do it right there. 
 
Once there, you can answer the questions and select your phone number from a list that will be 
presented. 
 
Once you have your number, you’ll now have to set up certain parameters so that the number works for 
you as you desire. 
 
The first thing you’ll want to do is to establish your settings . Click on the gear on the right side of the 
screen, and then click “Settings.” The first tab is “Phones.” Since you already chose a number, you will 
see that number and “Chang/Port” and Delete and Transfer as available options. I do not recommend 
porting your mobile number as that will limit choices down the road. You will want a NEW GOOGLE 
VOICE NUMBER. 
 
Then you will see a list of options for forwarding calls. I forward calls to my mobile number, but you can 
select other options which include forwarding calls to up to six (6) other numbers. You can “Add another 
phone” by clicking on that link. 
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The next tab, “Voicemail & Text” allows you to record a greeting, play your greeting, set up an email alert, 
forward texts, add a PIN and to turn on transcribing messages. The “Calls” tab allows you to turn on Call 
Screening, and a number of other pretty self-explanatory options. 
 
“Groups and Circles” tab allows you to establish actions by grouping. In order to use this feature, your 
address book has to be part of Google Contacts. That feature is beyond the scope of this article at this 
time, but I’ll make a follow up. For now, all incoming calls will be treated the same. 
 
“Call Widgets” can be put on any web page, and allow people to call from that web page. When 
somebody clicks on the widget, we call them and connect them to you. Your number is always kept 
private. You can create multiple call widgets and have different settings for each of them. This, too, is 
beyond the scope of this article. “Billing” will allow you to set up Calling Credits. These can be used to 
make calls (outgoing) to other number, mostly in our case international numbers, at low rates. You can 
look up the rates for international calls. 
 
And, “Account” is some simple setups, language, time zone passwords, etc. 
 
On the left of the Google Voice page are two red boxes, “CALL” and “TEXT” that allow you to call another 
number using Google Voice. US numbers can be called for free and are connected to the phone you 
specify. For example, I can call someone from my Google Voice number and speak to them from my cell 
phone. I might do that because I do not want that person to see my real cell phone number. So, I click 
“CALL,” enter the number I wish to call and specify to connect the call to my cell phone. You may do the 
same for text messages by clicking the “TEXT” box and entering the mobile number and the message. 
 
So, let’s summarize the advantages that Google Voice provides: 

1. A new phone number with lots of control. The ability to allow or block callers, screen calls, 
forward calls to numbers by who made the call, and to transcribe and receive messages by 
email. 

2. An ability to make calls from your Google Voice number and speak from any device that’s 
handy to you at the time. 

3. It’s free. 
4. Depending upon your use, you will find many more advantages as you use these features. 

 
I am also referring you to a great article by Kim Komando at 
http://www.komando.com/tips/248497/3-great-things-you-never-knew-you-could-do-with-a-free-internet-phone-
number/all 
 
Again, if the link does not work, copy it into your browser’s URL window.  
 

 
 
OTG Cable/Adapter (On-the-Go)   
By Frank Ramsey, Editor, Akron Canton PCUG, Ohio, www.acpcug.org,  
aframsey (at) yahoo.com 
 
How do you accomplish the transfer of files between a mobile device and your PC? 
  
There are a number of methods, including connecting the device to a PC/MAC via a USB cable, use an 
application to connect over Wi-Fi and others. 
  
An additional method would be to transfer files to a USB Flash drive. Since few Android devices have a 
full- size USB Type A port, how do you connect a flash?  
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Enter the OTG Cable. A typical OTB cable is shown. 
One end is the USB Type A female, the other end 
typically USB micro male. These are available from a 
number of sources including eBay for prices ranging 
from under a $1 to $5 or more. 
  
You plug the flash drive into the Type A female 
connection and plug the USB micro male into the 
Android device.  
  
Typically the Android device will recognize the flash drive 
and eventually it will show up in File Manager. I say 
eventually because the flash drive must be scanned by 
the Android device. Depending on the size of the flash 
drive and the speed of the Android device, it may take a 
little time for the USB drive to show up. Be patient.  
  
Now you can copy files to/from the flash drive. 
  
 
 
 
 
 
 
 
 
 
 
 
 

 
 
Could You Save By Changing Fonts? 
By Ilona Merritt, Editor, The Journal of The Computer Club of Sun City Center, FL 
www.scccomputerclub.org/   ilonamerritt7201 (at) gmail.com 
  
The U. S. government uses Times New Roman or Century Gothic font in all of its documentation. It was 
recently discovered that if the feds switch to Garamond — which uses thinner strokes for its letters, which 
means less ink used per letter — they could save $136 million per year. Maybe we should all change. 
 
The above article was sent to me by Jack Fischer for the Journal. That $136 million really peaked my 
curiosity and so it was off to Wikipedia for some lessons in fonts.  
 
Personally I either like a font or I don’t and I have more fonts in my computer than should be allowed. 
When I design flyers or invitations, etc. I frequently study my font file or will look for something new to fit a 
specific purpose. However, it is very important that an absolute minimal number of different fonts are used 
in one publication ... that is if you want anyone to read what you produced. Why? The more fonts are used 
the more the eye has to adjust and causes one’s eyes to tire easily. Ergo ... the person stops reading and 
your work goes into the waste basket.  
 
I researched Times New Roman, Century Gothic, Garamond and Minion. Each font described is written in 
that typeface and all are at 12 point. 
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TIMES NEW ROMAN gets its name from the Times of London, the British newspaper. In 1929, the 
Times hired typographer Stanley Morison of Monotype, a British font foundry, to create a new text font.  
 
After Monotype completed Times New Roman, it had to license the design to then-rival Linotype, because 
the Times used Linotype’s typesetting machines. (Think of Monotype and Linotype as the Depression-era 
Microsoft and Apple.) Since then, Monotype has sold the font as “Times New Roman” and Linotype has 
marketed its version as “Times Roman.” 
 
Typesetting technology has evolved, but due to its enduring popularity, Times New Roman has always 
been one of the first fonts available in each new format. Objectively, there’s nothing wrong with Times 
New Roman. It was designed for a newspaper, so it’s a bit narrower than most text fonts. Times New 
Roman is a workhorse font that’s been successful for a reason. 
 
CENTURY GOTHIC is a geometric sans-serif typeface designed for Monotype Imaging in 

1991. It is a digital typeface that has never been made into actual foundry type.  

 

The Century Gothic face is distinct for its single-story lowercase a and g. Century Gothic 

is more closely related to Avant Garde Gothic, designed by Herb Lubalin, and released 

by the International Typeface Corporation (ITC) in 1970. Century Gothic is similar to ITC 

Avant Garde in its pure geometry, and does not possess the subtle variation in stroke 

width found in either Futura or Twentieth Century.  
 
GARAMOND is the name given to a group of old-style serif typefaces named after the punch-cutter Claude 
Garamont (also spelled as Garamond, Latinised as garamondus) (c. 1480–1561). Many of the Garamond faces 
are more closely related to the work of a later punch-cutter, Jean Jannon. A direct relationship between 
Garamond’s letterforms and contemporary type can be found in the Roman versions of the typefaces Adobe 
Garamond, Granjon, Sabon, and Stempel Garamond. 
 
Garamond is considered to be among the most legible and readable serif typefaces for use in print (offline) 
applications. It has also been noted as using much less ink than Times New Roman at similar size. 

 
MINION (TYPEFACE)  is a digital typeface designed by Robert Slimbach in 1990 for Adobe Systems. 
The name comes from the traditional naming system for type sizes, in which minion is between nonpareil 
and brevier. It is inspired by late Renaissance-era type.  
 

Minion Pro — An Open Type update of the original family, released in 2000. The font was designed 
based on Minion MM, but with redesigns, which include slight changes to the selection of instances, and 
also alteration of font metrics.   
 

Minion Pro is rapidly becoming THE FONT TO USE ... I have been using it for the Computer Club 
Journal for well over two years.  
 
Now do you see what I mean about using too many fonts? I apologize! 
 
(Editor’s note - I don’t have Minion Pro typeface on my computer so this is not a true representation of that 
font.  Minion Pro may be included in some Adobe products and is available to purchase from Adobe for 
$135.00/set) 
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The Hidden Tabs in Microsoft Office 
By Nancy DeMarte, 1st VP, Sarasota PCUG, Florida 
www.spcug.org, ndemarte (at) Verizon.net 
 
Unless you are a frequent user of programs in Microsoft Office version 2007 or later, it’s easy to become 
overwhelmed by all the commands on the Ribbon. Well, I have news for you. Those tabs along the top of 
the ribbon contain only the tools that were determined by studies to be used most often for everyday 
tasks. There is a whole other group of tabs in Office programs which appear only when needed. Called 
Contextual tabs, they are one of the most useful additions to the newer Office versions.  
 
A contextual tab is a hidden tab that is displayed on the right end the tab row of the ribbon, but only when 
an object in the workspace is selected. Depending on what kind of object is selected, one or more tabs 
may appear. Above these tabs is their title, such as Table Tools or Drawing Tools, or, as shown in Figure 
1, Picture Tools. Note that these titles are always colorful, perhaps to attract your attention that they are 
available. Tools on the Picture Tools Format tab can help you set a specific size for the photo, apply 
styles or special effects like shadow or glow, and do simple photo editing. 
 

 
Figure 1: Partial View of the Picture Tools Format tab in Word 2010 
 
Sometimes you have to click the actual tab to open it. Other times, as in Figure 1, it opens by itself. As 
soon as you move away from the object, the tab disappears. For example, if you insert a table into a Word 
document, Excel spreadsheet, or PowerPoint presentation, the title Table Tools and two new tabs show 
up at the right end of the ribbon: Design and Format. You must click one of the tabs beneath the title to 
reveal the applicable tools. Figure 2 shows part of the contextual Layout tab which is open in a Word 
document that contains the table you have selected. 
 

 
Figure 2 Partial Table Tools Layout tab in Word 2010 
 
This Layout tab gives you a variety of options, including aligning text and objects within the table, “auto 
fitting” the table to its contents or the window, and splitting or merging cells. Clicking the Design tab 
presents a group of tools for formatting the table with borders, styles and shading.  These two tabs 
contain almost every command you need to work with a table except basic font and paragraph options, 
which are on the Home tab.  
 
This concept extends to any objects that are inserted into Office programs. For example, in Excel, if you 
insert a Pivot Chart, four contextual tabs appear, entitled PivotChart Tools. 
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Figure 3: PivotChart Tools with Design tab open in Excel 2010 
 
Some contextual tabs are found in several Office programs, such as Picture, Drawing, and Table. Others 
are program-specific, such as Excel’s PivotChart Tools. Excel has other exclusive tabs, too, such as Link 
Tools, Sparkline Tools, and Equation Tools. Even Microsoft Paint, part of the Windows operating system 
(not Office), has a Text tab under the title, Text Tools, which appears when you click the text icon (A) on 
the Home tab. Word and PowerPoint share many of the same contextual tabs, such as those described 
above, plus SmartArt Tools and Header and Footer Tools. PowerPoint, the slide presentation program, 
has a few unique tabs, such as Audio Tools, shown in Figure 4. Almost anything that can be inserted into 
an Office file has contextual tabs. 
 

 
Figure 4: Audio Tools Playback tab in PowerPoint 2010 
 
Here are three advantages to this system of contextual tabs that I have observed: 

1. The critical tools for working with inserted objects are located on these tabs, so you don’t have 
to search for them. 

2. You don’t have to do anything to make them visible. They pop up automatically when you 
select an object. 

3. Because they hide when not needed, they don’t clutter the screen.  
 
The commands on these contextual tabs include some of the newest and best tools that have made 
Microsoft Office a leader in the Office suite world. I’m not sure I have even found all the contextual tabs 
yet, but I have used many of them and have appreciated their convenience. I think these hidden tabs 
were one of the most creative and helpful improvements in Office in a long time.  
 

 




